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Predgovor 

Današnje društvo obilježeno je naglim rastom i razvojem 

informacijske tehnologije (IT), što je rezultiralo velikom ovisnošdu 

društva, u širem smislu, o znanju i kompetencijama osobe u IT 

području. I premda ta ovisnost raste iz dana u dan, ljudsko pravo na 

obrazovanje i informacije nije prošireno i na IT područje. Pojavili su 

se problemi koji utječu na društvo u cjelini, koji stvaraju prepreke i 

udaljavaju ljude od glavnog razloga i motivacije za napredak, od 

prilike. Danas, biti računalno nepismena osoba, znači biti osoba koja 

nije u mogudnosti sudjelovati u modernom društvu, osoba bez prilike, 

i unatoč priznatoj neophodnosti i korisnosti inkluzivne informatičke 

pismenosti, od strane Europske komisije, UNESCO-a, OECD-a i ostalih 

relevantnih institucija, još uvijek postoje grupe ljudi sa otežanim 

pristupom osnovnoj računalnoj naobrazbi (npr. osobe s invaliditetom, 

osobe s poteškodama u učenju, radnice/i migranti, nezaposlene 

osobe, osobe koje žive na udaljenim mjestima gdje nemaju pristup 

računalnoj edukaciji). 

 

Ove skripte, zajedno sa ostalim materijalom objavljenim na stranici 

ITdesk.info, predstavljaju naš doprinos realizaciji I promociji ljudskog 

prava na edukaciju i informacije u IT području. Nadamo se da de Vam 

ova edukacija pomodi u savladavanju osnovnih računalnih vještina i 

sa tom nadom želimo Vam da naučite što više i tako postanete 

aktivni/a član/ica modernog IT društva. 

 

Iskreno Vaši, 

ITdesk.info team 
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MICROSOFT WORD 2010 BETA – ELEMENTI SUČELJA 

 
1. Gumbi za manipulaciju prozorom – minimiziranje, maksimiziranje, zatvaranje prozora 

2. Naslovna traka – ime dokumenta, ekstenzija (.docx) te ime programa 

3. Kartice / tabs 

o Datoteka / File 

o Početna / Home 

o Umetni / Insert 

o Izgled stranice / Page Layout 

o Reference / References 

o Pošta / Mailings 

o Prikaz / Review 

o Pogled / View 

4. Trake s alatima / Toolbars 

o neke naredbe skrivene, imaju strelicu pokraj za otvaranje dodatnih opcija  

o zasivljene naredbe se ne mogu trenutno izvršiti (na slici: Change List Level) 

o naredbe s tri točke imaju slijed daljnjih naredbi (na slici: Define New Bullet...) 

 kartice i alatne trake zajedno se nazivaju vrpca (ribbon) 

5. Radna površina – papir, ovdje upisujemo tekst, ubacujemo objekt 

6. Točka umetanja, mjesto gdje treperi kursor 

7. Trake za horizontalnu i vertikalnu navigaciju (klizači) 

o dvostruka strelica gore/dolje prebacuje pogled za jednu stranicu više/manje 

8. Statusna traka 

o prikazuje podatke o trenutnom položaju točke umetanja na radnoj površini i stanje nekih 

specijalnih funkcija Microsoft Word-a 

9. Ravnala - horizontalno i vertikalno ravnalo, iznad i s lijeve strane sučelja 

o bijelo područje označava prostor za pisanje, sivo područje predstavlja margine 
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OZNAČAVANJE TEKSTA 

 

Prije uređivanja teksta potrebno je označiti dio teksta nad kojim de se izvršiti određeno oblikovanje. 

Označavanje proizvoljnog teksta: 

 pritisnemo i zadržimo lijevu tipku miša, prijeđemo mišem od početka do kraja teksta koji 

želimo označiti te otpustimo lijevu tipku 

 postavljanjem točke umetanja na mjestu početka označavanja, pritiskom na tipku Shift te 

pritisnuti lijevu tipku miša na mjestu željenog završetka označavanja 

Označavanje jedne riječi: dvostruki pritisak lijeve tipke miša na riječ. 

Označavanje jedne rečenice: pritisnemo tipku Ctrl i pritisak lijeve tipke miša bilo gdje u željenoj 

rečenici. 

Označavanje jednog retka: u prostoru margine lijevo od retka pritisnemo lijevu tipku miša (pokazivač 

mora biti u obliku bijele strelice). 

Označavanje više redaka: u prostoru margine lijevo od redaka, pritisnemo i zadržimo lijevu tipku miša 

te se pomičemo gore ili dolje preko redaka koje želimo označiti te otpustimo tipku miša. 

Označavanje nesusjednih redaka: u prostoru lijeve margine pritisnemo tipku Ctrl + pritisnemo lijevu 

tipku miša na željene retke.  

Označavanje jednog odlomka: - u prostoru margine lijevo od odlomka, dvostruki pritisak lijeve tipke, 

ili trostruki pritisak lijeve tipke miša unutar odlomka. 

Označavanje cijelog dokumenta: trostruki pritisak lijeve tipke miša u prostoru lijeve margine, ili 

prečica na tipkovnici Ctrl + A. 

 

UMNOŽAVANJE TEKSTA UNUTAR DOKUMENTA I IZMEĐU OTVORENIH 

DOKUMENATA 

 

 Kopiraj / zalijepi (Copy / Paste): 

1. označimo tekst koji želimo kopirati 

2. kopiramo označeni dio teksta pomodu alata Kopiraj (Copy)  (Ctrl + C) 

3. postavimo točku umetanja na mjesto gdje želimo smjestiti tekst 

4. zalijepimo tekst na to mjesto pomodu alata Zalijepi (Paste)  (Ctrl + V) 

 Kopiranje pomodu metode uhvati – vuci – pusti (drag and drop) 

1. označimo tekst koji želimo kopirati 

2. na označenom tekstu pritisnemo i zadržimo lijevu tipku miša te pritisnemo i zadržimo 

tipku Ctrl.  

3. vučemo pokazivač miša 

4. otpustimo tipku miša i potom tipku Ctrl. Tekst je zalijepljen na novu poziciju. 
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 Izreži / zalijepi (Cut / Paste): 

1. označimo tekst koji želimo premjestiti 

2. izrežemo označeni dio teksta pomodu alata Izreži (Cut)   (Ctrl +X) 

3. postavimo točku umetanja na mjesto gdje želimo smjestiti tekst 

4. zalijepimo tekst na to mjesto pomodu alata Zalijepi (Paste)   (Ctrl + V) 

 Premještanje pomodu metode uhvati – vuci – pusti (drag and drop): kao i kopiranje, ali bez 

tipke Ctrl 

 

 

Brisanje teksta slovo po slovo: tipka Delete briše znak desno od kursora, a tipka BackSpace briše znak 

lijevo od kursora 

o brži način brisanja - označimo željeni dio teksta i pritisnemo tipku Delete 

 

 

PONIŠTAVANJE IZMJENA (UNDO) I PONIŠTAVANJE PONIŠTAVANJA IZMJENA (REDO) 

Poništi (Undo)     Ponovi (Redo)  

Pritiskom na strelicu pokraj alata otvara se padajudi izbornik sa popisom svih akcija koje smo 

napravili. 

 

 

Uvijek prvo označimo tekst pa odaberemo željeni alat,  

strelica prema dolje pokraj alata daje dodatne opcije 

 

  



ITdesk.info – projekt računalne e-edukacije sa slobodnim pristupom 

ITdesk.info is licensed under a Creative Commons Attribution-  

Noncommercial-No Derivative Works 3.0 Croatia License.  4/12 

IZBORNIK: DATOTEKA / FILE 

 
 

Stvaranje novog dokumenta: New > Blank document > Create (prečica na tipkovnici Ctrl + N) 

 

Otvaranje postojedeg dokumenta - alatom Otvori / Open  (prečica na tipkovnici Ctrl + O) 

Otvaranje više od jednog dokumenta: uz pomod tipke Ctrl ili Shift 

 

Alat Spremi (Save)  (prečica na tipkovnici Ctrl + S) 

 Spremi u / Save in - u koju mapu de se dokument spremiti 

 Ime datoteke / File name - upišemo naziv datoteke 

 Spremi kao tip / Save as type – program u kojem spremamo dokument (MS Word .docx) 

 

Olakšano je kreiranje novog dokumenta korištenjem predloška – ekstenzija .dotx 

 

Options > kartica Save > Save AutoRecover info every (odrediti ) 

 

Ispis / Print: 

 Printer – odabiremo pisač 

 Page range: All – sve Current page – trenutna Pages – odabir stranica 

 Copies – broj kopija dokumenta 

 Collated – ispisuje se cijeli dokument od početka do kraja, a zatim prema zadanom broju 

kopija; Uncollated – ispisuje se prva stranica prema zadanom broju kopija, zatim druga itd 

 Margins – od nekoliko ponuđenih veličina margina odaberemo jednu 

 Orijentacija / Orientation:  

o Portrait (vertikalan papir)  

o Landscape (horizontalan papir)   
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KARTICA: POČETNI / HOME 

 
 

Vrsta slova (font): Times New Roman, Verdana, Ariel, Calibri (na slici) itd. 

Veličina slova / Font Size – padajudi izbornik    

 

Oblikovanje teksta:    

Podebljanje (Bold) 

- Ctrl + B 

Zakošenje (Italic)  

- Ctrl + I 

Podvlačenje (Underline)  

- Ctrl + U - tipkovna prečica 

 

Primjena efekata (precrtavanje, indeksiranje, eksponiranje)  

 Precrtani tekst (Strikethrough) nekakav tekst 

 Indeks (Subscript)  H2O > H2O;  

 Eksponent (Superscript) 5 m2 > 5 m2 

Kliknemo na sivu strelicu pokraj „Font“  (ili prečica na tipkovnici Ctrl + D) - ostali efekti koji se 

mogu primijeniti su: Dvostruko precrtano (Double Strikethrough), Sjena (Shadow), Kontura (Outline), 

Reljefno (Emboss), Ugravirano (Engrave), Smanjena velika slova (Small caps), Sve velika slova (All 

caps), Skriveni tekst je skriven pri ispisu (Hidden) 

 

Mala slova pretvoriti u velika ili obrnuto:  - VELIKA SLOVA / UPPERCASE  

- mala slova / lowercase 

Text Effects  - sadrži opcije oblikovanja teksta: Sjena / Shadow, Odsjaj / Reflection 

Text Highlight Color  - alat za isticanje teksta bojom 

Sjenčanje / Shading  - alat za bojanje pozadine teksta 

Obrubi / Borders  - alat za postavljanje raznih vrsta linija oko označenog teksta 

Bojanje teksta različitim bojama: alat Font Color  

 

Grafičke i numeričke liste: 

Grafičke liste / Bullets       Numeričke liste / Numbering     

 umetanje nove označene stavke – Enter na tipkovnici, prestanak označavanja – dva puta 

Enter 

 

Poravnanje teksta  

Poravnaj: lijevo / Align Left, po sredini / Centar, desno / Align Right, obostrano / Justify 
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Odabir proreda unutar odlomka - alat Line Spacing   

Prikazivanje i sakrivanje znakova koji nisu za ispis - Alat Show / Hide  

 

Stilovi: 

 primjena stila – nakon označavanja teksta, kliknemo na ponuđeni stil / style 

o Ili pritisnemo  kod izbornika stilova > odaberemo stil > Primjeni stil / Apply Style  

 izmjena stila - pritisnemo  > Primjeni stil > Izmjeni (Apply Style > Modify)  

 izrada novog stila: označimo tekst sa željenim oblikovanjem, pritisnemo  kod izbornika 

stilova > Spremi označeno kao novi stil / Save Selection as a New Quick Style 

 

Traženje određene riječi ili fraze   

 Nađi / Find, upišemo frazu, Pronađi slijedede / Find Next 

Zamjena određene riječi ili fraze 

 Find What – koju riječ tražimo 

 Replace With - čime želimo zamijeniti 

 

Prenošenje oblikovanja sa jednog dijela teksta na drugi - alat Format Painter  

Pomod u MS Wordu - alat Help  , F1 na tipkovnici  

 

 

KARTICA: UMETANJE / INSERT 

 
 

Prijelom stranice / Page Break  

 uklanjanje prijeloma: uključimo Show / Hide, selektiramo oznaku Page Break, tipka Delete 

 

 

Zaglavlje i podnožje (Header and Footer)   

 editiranje: dvostrukim klikom u prostor zaglavlja ili podnožja; ili: pritisak na desnu tipku miša i 

odabir naredbe Uredi / Edit 

 izlazimo iz polja zaglavlja/podnožja: dvostruki klik na radnu površinu aplikacije 

 

Umetanje polja (Quick Parts > Field...)  možemo umetnuti: broj stranice, datum, 

vrijeme, autora/icu dokumenta itd. 
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Automatsko numeriranje stranica   

 Vrh stranice / Top of page,    

 Dno stranice / Bottom of page 

 te lijevi ili desni kut, ili sredina stranice  

 

Tablice  

 umetanje tablice: mišem prelazimo preko kockica čime određujemo broj stupaca i redaka;  

o ili odaberemo opciju Umetni tablicu / Insert Table i upišemo brojeve  

 promjena položaja točke umetanja: tipka Tab, tipke sa strelicama na tipkovnici, pritiskom 

lijeve tipke miša u željenu deliju 

 uređivanje tablice: Table Tools > Obrubi / Borders 

> Sjenčanje / Shading  

 naknadno umetanje retka ili stupca: 

o točku umetanja pozicioniramo u deliju gdje želimo umetnuti redak ili stupac, pritisnemo 

desnu tipku miša te na brzom izborniku odaberemo Umetni > red iznad (Insert > Row  

Above) ili ispod (Below)   

o ili Umetni > stupac lijevo (Insert > Column Left) ili desno (Right) 

 brisanje retka ili stupca 

o označimo redak ili stupac, pozovemo brzi izbornik te izaberemo opciju Obriši stupce 

(Delete Columns) ili Obriši retke (Delete Rows) 

o brisanje tablice: označimo tablicu i pritisnemo tipku Delete  

 

Slike  

 označavanje slike radimo pritiskom lijeve tipke miša na željeni objekt, nakon čega objekt na 

obrubu dobije kvadratide 

 za pomicanje slike na proizvoljno mjesto: označimo sliku, desna tipka miša > Format Picture > 

Layout > Wrap, odaberemo stil 

 podešavanje veličine objekta 

o ručno: označimo objekt, pomičemo neke od rubnih točaka na okviru objekta 

o upisom vrijednosti: desni klik na objekt > Format Picture > kartica Size > unijeti vrijednosti 

za visinu (Height) i širinu (Width) 

 

Umetanje simbola    €   £   ©  ∞    ≠                itd. 

 

KARTICA: IZGLED STRANICE / PAGE LAYOUT 
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 Margine / Margins: odaberemo ponuđene margine s obzirom na željenu visinu, širinu 

 Orijentacija / Orientation: Portrait – okomito postavljen papir; Landscape – vodoravno 

postavljen papir, za tablice 

 Veličina / Size - podešavanje dimenzija papira 

 Automatska funkcija za rastavljanje riječi / Hyphenation  

o None (nikakva), Automatic, Manual 

 Obrub stranice / Page borders – različite vrste i debljine linija mogu biti obrub i cijeloj stranici 

 Uvlaka / Indent - uvučenost retka 

 

KARTICA: POŠTA / MAILINGS 

 

Skupno pismo, pismo s istim sadržajem koje šaljemo na više adresa 

 Kreiranje: Start Mail Merge > Step by Step Mail Merge Wizard (kao na slici iznad) 

1) Odabir vrste dokumenta na kojem želimo kreirati skupno pismo 

• Pismo – tekst koji se razlikuje samo po umetnutim poljima  

• Poruka e-pošte – kao i kod pisma 

• Omotnice – ispis imena i adrese primatelja 

• Naljepnice 

• Imenik – cijeli dokument predstavlja ispis po poljima podataka iz baze podataka 

 

2) Odabir polaznog dokumenta 

• Upotrijebi tekudi dokument – dokument koji upravo koristimo 

• Počni od predloška – odaberemo predložak 

• Postojedi dokument – navigiramo do i otvorimo postojedi dokument 

 

3) Odabir primatelja 

• Koristi postojedi popis – koristimo imena i adrese iz datoteke ili baze podataka 

• Izaberi među kontaktima u Outlook-u / Select from Outlook contacts 

• Utipkaj novi popis > kreiraj  / Type a new list > Create 

 

4) Organizacija svoje datoteke / Arrange your directory – dodajmo informacije o 

primatelju: odredimo mjesto u dokumentu te kliknimo na jednu od stavki: Adresni 

blok, Pozdravi itd. 
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5) Pregled svoje datoteke / Preview your directory – također možemo urediti popis 

primatelja  

 

6) Završavanje skupnog pisma / Complete the merge 

 

KARTICA: PRIKAZ / REVIEW 

 
 

 riječi koje su krivo upisane biti de podvučene crvenim, valovitim linijama 

 podešenja: Review > Language > Set Proofing Language 

 Alat Spelling and Grammar  - otvara se dijaloški okvir sa opcijama: ignororaj jednom, 

ignoriraj sve, promjeni, promjeni sve (Ignore once, Ignore all, Change, Change all) 

 ako se neka riječ ne nalazi u rječniku tada ju možemo unijeti u rječnik označivši je > pritisak 

desne tipke miša nad označenom riječi > Add to dictionary 

 

 

KARTICA: POGLED / VIEW 

 
 

 slijededi alati se nalaze u kartici Pogled/View  i u donjem desnom kutu aplikacije (na 

Statusnoj traci): 

o Print Layout - kako de se na ispisnoj stranici raspodijeliti tekst i različiti objekti, najčešde 

korišteni pogled 

o Full Screen Reading - pogodan za čitanje dokumenta  

o Web Layout - pogled se koristi za izradu web stranice 

o Outline – pogled na strukturu dokumenta; olakšan rad sa premještanjem, kopiranjem, 

uređivanjem teksta te promjenom nivoa naslova 

o Draft – pogled na dokument kao na nacrt; određeni elementi kao npr. zaglavlje se ne vidi 

o Zoom – odabir ponuđene ili unos vrijednosti 

Page Width - prikaz po širini stranice 

Text Width - prikaz po širini teksta 

Whole Page – prikaz čitave stranice 

Two Pages – prikaz dviju stranica 
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Upotreba tabulatora 

 pritiskom na tipku TAB na tipkovnici, točka umetanja se pomakne za 1,25 cm udesno 

 upotrebom tabulatora, možemo točno definirati gdje želimo da se pomakne točka umetanja 

 tabulatori:  

 - lijevi tabulator 

 - tabulator centriranja 

 - desni tabulator  

 - decimalni tabulator 
 

 ravnalo / Ruler treba biti vidljivo  

 ikona tabulatora s lijeve strane ravnala omoguduje nam odabir vrste tabulatora 

 na željenu poziciju na ravnalu pritisnemo lijevu tipku miša 

 tipkom TAB prelazimo od jednog do drugog tabulatora 

 uklanjanje tabulatora: pritisnemo i zadržimo lijevu tipku miša na njemu te povučemo prema 

dolje i potom otpustimo tipku miša 
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Ova skripta je namijenjena za učenje uz materijale 

objavljene na slijedećim linkovima: 

 

 

* Priručnik: 

http://www.itdesk.info/prirucnik_obrada_teksta_microsoft_word_2010.pdf   

 

 

* Video prezentacije koje prikazuju rad u Microsoft Word 2010: 

 http://www.itdesk.info/hrvatski/microsoft-word-1/ 

 http://www.itdesk.info/hrvatski/microsoft-word-2/ 

 http://www.itdesk.info/hrvatski/microsoft-word-3/ 

 http://www.itdesk.info/hrvatski/microsoft-word-4/ 

 

 

* Probni ispit:  

http://www.itdesk.info/primjeri ispita/primjer ispita modul 3.pdf  

 

 

* Video-prezentacija koja prikazuje rješavanje primjera ispita: 

http://www.itdesk.info/hrvatski/obrada-teksta-microsoft-word-2010-video-rjesenje-ispita/  

 

 

* Kvizevi koji korisnici/ce sami rješavaju: 

 http://www.itdesk.info/hrvatski/obrada-teksta-kviz-1/ 

 http://www.itdesk.info/hrvatski/obrada-teksta-kviz-2/ 

 http://www.itdesk.info/hrvatski/obrada-teksta-kviz-3/ 

 

 

(za otvaranje linka koji se nalazi unutar .pdf dokumenta samo pritisnite lijevu tipku miša na 

jedan od navedenih linkova. Web stranica na koju link pokazuje de se otvoriti u Internet 

pregledniku kojeg imate instaliranog na računalu.) 

  

http://www.itdesk.info/prirucnik_obrada_teksta_microsoft_word_2010.pdf
http://www.itdesk.info/hrvatski/microsoft-word-1/
http://www.itdesk.info/hrvatski/microsoft-word-2/
http://www.itdesk.info/hrvatski/microsoft-word-3/
http://www.itdesk.info/hrvatski/microsoft-word-4/
http://www.itdesk.info/primjeri%20ispita/primjer%20ispita%20modul%203.pdf
http://www.itdesk.info/hrvatski/obrada-teksta-microsoft-word-2010-video-rjesenje-ispita/
http://www.itdesk.info/hrvatski/obrada-teksta-kviz-1/
http://www.itdesk.info/hrvatski/obrada-teksta-kviz-2/
http://www.itdesk.info/hrvatski/obrada-teksta-kviz-3/
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Opdi uvjeti korištenja: 

Web stranicu www.ITdesk.info je pokrenula udruga „Otvoreno društvo za razmjenu 

ideja - ODRAZI“ u sklopu aktivnog promoviranja ljudskog prava na slobodan 

pristup informacijama te ljudskog prava na edukaciju. 

Slobodno kopirajte i distribuirajte ovaj dokument, uz uvjet da ne mijenjate ništa u 

njemu! 

 

Nad svim programima i uslugama navedenim na web stranici ITdesk Home na web adresi ITdesk.info 
isključivo pravo posjeduju njihovi autori/ce. Microsoft, Windows, i Windowsxx su registrirani zaštitni 
znakovi tvrtke Microsoft Corporation. Ostali zaštitni znaci korišteni na ITdesk Home Web stranicama 
su isključivo vlasništvo njihovih vlasnika/ca. Ukoliko imate pitanja vezana uz uporabu ili redistribuciju 
bilo kojeg programa, molimo kontaktirajte autore/ice dotičnog programa. Sva dodatna pitanja 
pošaljite na info@itdesk.info.  

Ove web stranice sadržavaju linkove na ostale web stranice ili izvore. ITdesk.info team NIJE 
odgovoran za tekstualni i/ili reklamni sadržaj, odnosno za proizvode koji su na tim web 
stranicama/izvorima ponuđeni, kao sto NIJE odgovoran niti za sadržaj koji je putem njih dostupan; 
mogudnost korištenja ili točnost sadržaja. Linkove koristite na vlastitu odgovornost. Također, 
ITdesk.info team ne garantira: 

 da je sadržaj na ovim web stranicama oslobođen od pogrešaka ili pogodan za svaku svrhu, 

 da de ove web stranice ili web usluge funkcionirati bez pogrešaka ili prekida, 

 da de biti odgovarajudi za vaše potrebe, 

 da implementacija takvog sadržaja nede narušavati patente, autorska prava, zaštitni znak ili 
ostala prava neke trede strane. 

Ukoliko se ne slažete s ovim opdim uvjetima korištenja ili ako niste zadovoljni web stranicama koje 
pružamo, prekinite s korištenjem ovih web stranica i web usluga. ITdesk.info team nije odgovoran 
vama, niti tredim osobama za bilo koju nastalu štetu, bila ona direktna, indirektna, slučajna ili 
posljedična, povezana s ili proizlazeda iz vaše uporabe, pogrešne uporabe ovih web stranica ili web 
usluga. Iako vaše potraživanje može biti bazirano na garanciji, ugovoru, prekršaju ili nekom drugom 
pravnom uporištu, neovisno o našoj obaviještenosti o mogudnosti nastanka takve štete, oslobađamo 
se svake odgovornosti. Prihvadanje ograničenja naše odgovornosti nužan je preduvjet korištenja ovih 
web stranica i web usluga. 

Svi softveri navedeni u ovom ili drugim dokumentima objavljenim na stranici ITdesk.info su navedeni 

samo za edukativne svrhe ili kao primjer te mi, na bilo koji način, ne preferiramo navedeni softver u 

odnosu na neki drugi softver. Bilo koju izjavu da neki navedeni softver preferiramo više u odnosu na 

drugi, koji se spominje ili ne spominje u materijalima, smatrat de se kao lažni iskaz. Našu izravnu i 

bezrezervnu podršku imaju jedino softveri otvorenog koda (open source) koji omoguduju 

korisnicima/cama da bez prepreka postanu digitalno pismeni, koriste računalo i sudjeluju u 

modernom informatičkom društvu.  

http://www.itdesk.info/
mailto:info@itdesk.info
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